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1 Legal Notices
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed to the U.S. Government under vendor’s standard commercial
license.
The information contained herein is subject to change without notice. The only warranties for HP products
and services are set forth in the express warranty statements accompanying such products and services.
Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical
or editorial errors or omissions contained herein.

Warranty
A copy of the specific warranty terms applicable to your HP product and replacement parts can be obtained
from your local Sales and Service Office.

Restricted Rights Legend
Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph
(c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 for DOD
agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer Software Restricted Rights
clause at FAR 52.227-19 for other agencies.

HEWLETT-PACKARD COMPANY
3000 Hanover Street
Palo Alto, California 94304 U.S.A.
Use of this documentation and any supporting software media supplied for this pack is restricted to this
product only. Additional copies of the programs may be made for security and backup purposes only. Resale
of the programs, in their present form or with alterations, is expressly prohibited.

Copyright Notice
© Copyright 2004-2008 Hewlett-Packard Development Company, L.P.

Trademark Notices
HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32- and 64-bit configurations)
on all HP 9000 computers are Open Group UNIX 95-branded products.
Java is a U.S. trademark of Sun Microsystems, Inc.
Linux is a U.S. registered trademark of Linus Torvalds.
Microsoft, Windows, and Windows NT are U.S. registered trademarks of Microsoft Corporation.
UNIX is a registered trademark of The Open Group.

Revision History
Revision History

February 2008Revision Version 3.2
MPN: 381270-401. Version 3.2 adds new product functionality and features.

September 2007Revision Version 3.1
MPN: 381270-009. Version 3.1 adds new product functionality and features.

May 2007Revision Version 3.0
MPN: 381270-008. Version 3.0 adds new product functionality and features.

March 2007Revision Version 2.4
MPN: 381270-007. Version 2.4 adds new product functionality and features.

January 2007Revision Version 2.3
MPN: 381270-006. Version 2.3 adds new product functionality and features.

September 2006Revision Version 2.2
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MPN: 381270-005. Version 2.2 added new product functionality and features.
May 2006Revision Version 2.1

MPN: 381270-004. Version 2.1 added new product functionality and features.
July 2005Revision Version 1.3
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2 Overview
HP BladeSystem Integrated Manager is an HP Systems Insight Manager (HP SIM) plugin that enables you
to manage blade systems from HP SIM. HP BladeSystem Integrated Manager is comprised of blade computer
systems, integrated connectivity to data and storage networks, and shared power subsystems. The HP
BladeSystem Integrated Manager enables you to quickly navigate your HP blade environments including
server blades and desktops, enclosure infrastructures, racks, and integrated switches, through hierarchical
tree views. Users are able to conveniently configure, deploy, and manage individual or groups of blade
systems.
To access the HP BladeSystem Page, select Tools→Integrated Consoles→HP BladeSystem from the
menu bar in HP Systems Insight Manager or from the Systems and Events panel,
Systems\Shared\Systems by Type\HP BladeSystem.

What's New in HP BladeSystem Integrated Manager 3.2
• Support for Microsoft Windows Server 2008.

• Support for c-Class Double Bay, full Height Integrity server BL870c

• Support for automatic creation of racks.
Starting with this version, racks are automatically created when they are discovered. These racks are
displayed under the All Racks option. These racks can be edited using the Edit Rack option.

• Support for c-class c3000 Tower model enclosures.

• Support for viewing the connection status of the DVD drive for c-class c3000 and c-class c3000 Tower
model enclosures.

• Added support for the following c-class interconnect modules:

HP GbE2c Layer 2/3 Ethernet Blade Switch•

• HP 1:10Gb Ethernet BL-c Switch

• Cisco Catalyst Blade Switch 3120G for HP

• Cisco Catalyst Blade Switch 3120X for HP

• 1/10Gb-F Virtual Connect Ethernet Fiber Module.

• Support for ProLiant BL685c G5 and ProLiant BL465c G5 servers.

• Support for 64-bit Windows Vista on ProLiant xw460c workstation blades.

• This version of HP BladeSystem Integrated Manager is compatible with OA firmware revision 2.10.

Related procedures

• HP BladeSystem page

• Viewing p-Class enclosures

• Viewing c-Class enclosures

Related topics

• Navigating the tree view page

• Navigating the table view page

• Navigating the icon view page

• Navigating the picture view page

What's New in HP BladeSystem Integrated Manager 3.2 9



HP BladeSystem page
The HP BladeSystem page defaults to a tree view to display:

• All p-Class enclosures for p-Class components including p-Class blades, switches, enclosures and racks

• All e-Class enclosures for Consolidated Client Infrastructure (CCI) blade PCs, e-Class blades and
enclosures

• All c-Class enclosures for c-Class components including c-Class blades, switches, c-Class enclosures,
Onboard Administrator

You can select one or more components. To select all of the HP BladeSystem components, select Select “HP
BladeSystem” itself.
The HP BladeSystem page can be viewed in the following ways:

• tree view

• icon view

• table view

Related procedures

• Viewing p-Class enclosures

• Viewing e-Class enclosures

• Viewing c-Class enclosures

• Onboard Administrator links

Related topics

• Navigating the tree view page

• Navigating the table view page

• Navigating the icon view page

• Navigating the picture view page

Navigating the tree view page
The tree view provides an automatically populated representation of the actual physical hierarchy of blade
components. For example, blades within enclosures within racks and is a good place to create and utilize
collections of components.
When a collection is selected in the Systems and Events panel or from the system table view page or
event table view page, the tree view is displayed in the workspace. The tree view is initially collapsed.
Systems might appear in multiple locations, because they can be in multiple collections. Users can view only
systems that they are authorized to see. Therefore, if a user is not authorized to view a particular system in
the tree, that branch is not displayed. The following sections are available on the tree view page:
1. Expanding the tree view
2. Tree view status
3. Tree view buttons
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Expanding the tree view
Branch nodes can be expanded by clicking the toggling expansion icon. However, the system name is not
an expansion control, but a drilldown. When a branch is collapsed, the icon appears as . When clicked,
the branch expands to show the child systems, and the icon toggles to . Clicking the icon again collapses
the branch and toggles the icon back.

NOTE: The expansion state persists only for the page session. When the page is reloaded or navigated
to again, a fresh tree is loaded. This is to ensure that all newly discovered systems are added to the view.

NOTE: The tree branch expansions differ from the Systems and Events panel and the workspace. In
the Systems and Events panel, the branch can be expanded by clicking the icons or the branch label. In
the workspace, the branch can be expanded by clicking the icon only, since clicking the system name invokes
the drilldown feature.

A paging mechanism is provided in the branches. When a branch is expanded, the first 100 systems are
displayed. To view additional systems, click next...of.... Clicking this link displays the remaining systems,
up to 100. If only one system remains in the next page, it is simply added to the page in place of the next
link.

At the top of each tree view there are two expansion buttons. To expand all branches of the tree, click .
To collapse all branches of the tree to first level branches, click . If there are too many systems to load
into the expand all page, a popup message appears stating that there are too many systems in the tree and
the function cannot be performed.

Selection in the tree view
The selection control for the tree view cycles through four states using the following check icons:

•
First, initial state, nothing selected.

•
Second state, both the container and the contents are selected. If the contents were not already expanded,
the next level of children are expanded to show the selection.
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•
Third state, all of the contents are recursively selected. The children are expanded (if not already) to
show they are selected. Only the next level is expanded.

•
Fourth state, just the container is selected.

Tree view status
The tree view displays status data for each system. The status icon is located in the left of the tree view next
to the selection checkbox. If the status of the systems is Unknown, no status icon appears. If the systems are
containers, the status to the left of the container name is shown as the most critical status of the systems in
the container, including the container status. The status of the container itself is displayed to the right of the
system name along with a system type label.

Available drilldowns
The tree view contains hyperlinks for the system name and status icon drilldowns. If a system name is clicked,
the System Page for that particular system appears. The status icons drilldown to the status URL for that
system, unless the status icon is the status icon to the left of a container. Clicking on the roll-up status of a
branch loads a table view of all the systems in that branch which match the roll-up status. Thus, you are
presented with all the systems that are contributing to the severity of the roll-up status.

Selection states for collections
In the tree view, you cannot select a collection and the members of the same collection simultaneously. When
a collection is selected, the members are displayed and their selection boxes are disabled. The selection
states for a collection are as follows:

•
The initial state, nothing is selected

•
The collection itself is selected and the contents of the collection are disabled

• .
The members of collection are selected; the collection itself is unselected

Additionally, there is a checkbox at the top of the tree that enables you to select the collection that is being
viewed. When the checkbox is checked, all the checkboxes under the collection are cleared and disabled.
When the checkbox is deselected, the checkboxes under the collection become selectable.

Tree view buttons
Three buttons at the bottom of the tree view page are available to users with full configuration rights.

• Save As Collection. When a system or group of systems is selected, this button is used to save the
selection with a new name. Changes are saved on a per-user.

• Delete. This button is used to delete one or more systems from the database. Select the systems to be
deleted, and click Delete. A dialog box appears. Click OK to continue with the deletion or click Cancel
to cancel the operation. The tree view is refreshed.

NOTE: Only systems can be deleted from the tree view. If a collection is selected, the Delete button
becomes disabled. Collections must be deleted through the Customize Collections page.

NOTE: If a VM Host is deleted, it can still be accessed through the Virtual Machine Management
Pack console, and the operations that can be performed on a VM Host are not affected by the deletion
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of the HP Systems Insight Manager (HP SIM) system. The Virtual Machine Management Pack console
continues to show the HP SIM status.

NOTE: If you select a collection by checking Select "collection name" collection itself, the Delete
button is disabled. To delete collections, go to the Customize Collections page.

• Print. Click Print to display a printable version of the tree. Print the tree from the browser by clicking
File→Print.

Print is available regardless of your rights, however the other options are only enabled if you have
appropriate rights.
Related topics

• Overview

• HP BladeSystem page

• Navigating the icon view page

• Navigating the table view page

Navigating the icon view page
The icon view lists the system name of all discovered systems as well as the System Health Status for each
system. The legend shows how many systems in the view are Critical, Major, Minor, Normal, Disabled, and
Unknown. Select the checkbox next to the system name to select a system. You can select more than one
system or to select all an entire collection, select Select "collection name" itself.

In HP Systems Insight Manager, a system has one of the following health status types:
Critical. HP Systems Insight Manager can no longer communicate with the system. The system was previously

discovered but cannot be pinged. The system might be down, powered off, or no longer accessible on the
network because of network problems.

Major. A major problem exists with this system, it should be addressed immediately. For systems running
HP Insight Management Agent, some component has failed. The system might no longer be properly
functioning, and data loss can occur. In Insight Manager (WIN32), this status was identified as Failed.

Minor. A minor problem exists with this system. For systems running Insight Management Agent, some
component has failed but the system is still functioning. In Insight Manager (WIN32), this status was identified
as Degraded.

Warning. The system has a potential problem or in a state that might become a problem.
Normal. The system is operating normally. The system is accessible.
Disabled. The system is suspended. This enables a system to be excluded from status polling, identification,

data collection, and automatic event handling. On the Automatic Discovery page, if you select the option
Automatically discover a server blade when its iLO is identified, new servers discovered through
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Integrated Lights Out (iLO) (for example, no operating system or IP address known) are shown as disabled,
until the system is discovered with an IP address or operating system.

Unknown. HP Systems Insight Manager is not able to obtain management information about the system
using SNMP or DMI. Although no management instrumentation information is available, the system can be
pinged. It might have an invalid community string or security setting, or it might be an IP address that is no
longer associated with a system.
No Status. The system has not been polled by one or more of the polling tasks since the system was discovered.

NOTE: HP Insight Management Agent for Servers for Windows continue to use the terms Normal, Degraded,
Failed, and Inaccessible. Minor and Major status are only associated with systems running these agents.

Informational. The system might be in a transitional state or a non-error state.
Related topics

• Overview

• HP BladeSystem page

• Navigating the tree view page

• Navigating the table view page

Navigating the table view page
The table view lists the system name and type and sorts information into columns. The legend shows how
many systems in the view are Critical, Major, Minor, Normal, Disabled, and Unknown. Place your cursor
over a column name for a brief description of that column. For more information regarding table view, see
the HP Systems Insight Manager Technical Reference Guide at http://h18013.www1.hp.com/products/
servers/management/hpsim/infolibrary.html.

System View Columns
Sort columns by clicking the column header for ascending or descending order. Place your cursor over a
column name for a brief description of the column. The columns are not available when you select the icons
view. See:

• Selection

• Health Status

• Management Processor

• Software Status

• HP ProLiant Essentials Performance Management Pack

• HP ProLiant Essentials Vulnerability and Patch Management Pack

• System Name

• System Address
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• Product Name

• Operating System Name

Selection
Select the checkbox in this column to select a system. You can select more than one system. This option is
available in the table view, tree view, and icon view. Select the checkbox in the column heading to select
or deselect all displayed systems. To select all of the HP BladeSystem components, select the checkbox Select
"HP BladeSystem" itself.

System Name
This column contains the actual system name of all discovered systems. Systems can be shown as a single
system or as a system in a container. When you place the cursor over the system name, the full system
Domain Name Service (DNS) name is shown, which helps differentiate between two or more systems that
share the same system name. If you click the system name link, the System Page appears. If you click a
system that is a container (rack or enclosure), the picture view for that object displays.
The System Name column displays systems along with their associated devices. The following list shows
the associations available in HP Systems Insight Manager:

• Management processor to server

• Server to enclosure

• Management processor to enclosure

• Enclosure to rack

• Switch to enclosure

• System to cluster

The following system types are containers:

• Rack

• Enclosure

• Cluster

Clicking an enclosure name in the System Name column produces a list of all discovered systems in the
selected enclosure. The status for both racks and enclosures is always Unknown.
When switches in blade enclosures are discovered and identified, associations are made between the
switches and the enclosures in which they reside. This association appears in the System Name column on
the system table view page by showing switch_name in Encl. enclosure_name. The System Type column
displays Switch as the system type. For HP Systems Insight Manager to identify and manage the HP ProLiant
p-Class server blades correctly, the HP Insight Management Agent 5.50 or later must be installed on the
blades to make associations work and event correlation function properly.
When a server blade is identified through another system in the same rack or enclosure, associations are
made between the iLO and the enclosures in which they reside. This association appears in the System
Name column on the system table view page by showing the system serial number prepended with Server_
in Encl. enclosure_name. For example, Server_C349KJP5D876 in Encl. Encl4. The system address, product
name, and operating system are not displayed for these systems.
To launch HP Serviceguard Manager to manage the server belonging to an HP Serviceguard cluster, be
sure that:

• HP Serviceguard Manager is installed and registered with HP Systems Insight Manager

• The system selected is an HP-UX or Linux server that belongs to an HP Serviceguard cluster

Health Status
The health status column (indicated by HS) displays the overall system health status, which is determined by
the default Hardware Status Polling task. By clicking the status icon in this column, the HP Management
Agents or the HP Instant Toptools for Servers page displays. If the system does not have Web Agents
or Instant Toptools installed, the System Page displays.

HP BladeSystem page 15



The hardware status displayed for container systems, such as Serviceguard or a complex, it is the actual
hardware status for the container itself. For clusters, it is the ping status.

Management Processor
The management processor column (indicated by MP) displays the status icon of the management processor,
if the system has an Integrated Lights-Out Board (iLO) installed. Otherwise, the Informational icon is displayed.
Clicking on the status icon displays the System Page for the management processor.

Software Status
The software status column (indicated by SW), available for servers only, indicates both the availability of
software updates and how critical they are.
If you click an Unknown status, HP Systems Insight Manager displays the Legacy Version Control page.
If HP Version Control Agent is installed on the system, clicking the software status icon for that system displays
HP Version Control Agent Software Inventory page. If you hover your cursor over the status icon and
the VCA is not installed on the system, a message appears that states Version Control Agent not
found.

HP ProLiant Essentials Performance Management Pack
The HP ProLiant Essentials Performance Management Pack (PMP) status column (indicated by PF) displays
the cumulative performance status of all monitored subsystems for the system. By clicking the status icon in
this column, the HP ProLiant Essentials Performance Management Pack page for the selected system
displays, providing more detailed performance information.

NOTE: If the PMP is not installed on the HP Systems Insight Manager system, this column does not display
on the system table view page.

If the PMP is not monitoring a server, the status is Unknown. If you click the status link, the PMP displays a
page with information about purchasing a license to monitor that system or shows notification that PMP
monitoring is not supported on that system.

NOTE: For the PF column, a status appears for all systems from the All Servers list. If the status cannot be
determined for some reason, the status is set to Unknown.

HP ProLiant Essentials Vulnerability and Patch Management Pack
VPM vulnerability information is displayed in the VPM column of the HP Systems Insight Manager console.
Initially, the icon depicted in the column displays VPM eligibility information for the target system in the
specific row. After target servers are licensed and a vulnerability scan is performed, the column displays the
combined status of the last vulnerability scan on the target system (patch status is not displayed in the column).
Click the icon to display detailed information about the system status with regard to VPM. Clicking the
Normal, Minor, or Major icons opens a new informational page where the last scan results for the system
can be accessed. A new scan can also be launched from this page. Clicking the Unknown icon for a system
displays an explanatory page listing possible reasons why VPM.

NOTE: If VPM is not installed on the HP Systems Insight Manager system, the Informational icon appears
in the VPM column on the system table view page. Clicking this icon displays information on how to install
VPM and purchase licenses.

If the system is not licensed or has not yet been scanned by VPM, the Informational icon appears in the VPM
column. Clicking this icon either displays details about licensing the target system and a link to the HP Systems
Insight Manager License Manager or information about vulnerability scanning and a link to scan for or patch
vulnerabilities on the target system.

HP ProLiant Essentials Virtual Machine Management Pack
HP ProLiant Essentials Virtual Machine Management Pack (Virtual Machine Management Pack) status column
(indicated by VM Status) displays the cumulative status of all Virtual Machine Hosts and Virtual Machine
Guests. Clicking the status icon on the VM Status column displays the HP ProLiant Essentials Virtual
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Machine Management Pack page for the selected system, providing more information on the status of the
Virtual Machine.

NOTE: When Virtual Machine Management Pack is not installed on the HP Systems Insight Manager
system, this column does not appear on the All Systems system table view page. Similarly, if HP ProLiant
Essentials Virtual Machine Management Pack is uninstalled, the VM Status is no longer updated in the HP
Systems Insight Manager console.

For systems with type as Server and subtype as Virtual Machine Host or Virtual Machine Guest, HP Systems
Insight Manager populates the VM Status column with appropriate status icons.

System Type
This column displays the system type, for example, Server, or Desktop. The system type Unmanaged indicates
systems that have no management protocol that HP Systems Insight Manager could detect, for example, no
Simple Network Management Protocol (SNMP), Web-Based Enterprise Management (WBEM), Desktop
Management Interface (DMI), or Secure Shell (SSH). The system type Unknown indicates systems that have
some management protocol but have not matched any identification rule in HP Systems Insight Manager.

NOTE: Unmanaged systems might indicate that the credentials were not set correctly in order to
communicate with the system. If you know that there are HP Insight Management Agents installed, verify the
credentials used.

Operating System Name
The operating system column (indicated by OS Name) displays the operating system on the system. For a
Serviceguard cluster, this column displays either HP Serviceguard if the cluster is of type HP-UX or HP
Serviceguard for Linux if the cluster is of type Linux. HP Serviceguard and HP Serviceguard for Linux
under the OS Name column of the virtual cluster system column do not represent the actual operating system
name and type. This field is used to let you know the servers that make up the cluster are of HP-UX or Linux
type, respectively.

System Address
This column displays the primary IP addresses of the system that HP Systems Insight Manager uses to
communicate with the system. Not all systems have and IP address, including HP Serviceguard clusters.

Product Name
This column displays the product name of the system.

System List Buttons
Three buttons at the bottom of the system table view page are available to users with full-configuration-rights.
These buttons are not available when using a tool and selecting an individual target system.

• Save As Collection. When a system is highlighted, this button is used to save the selection with a
new name. Changes are saved on a per-user, per-collection basis.

• Delete. This button is used to delete one or more systems from the database. Select the systems to be
deleted, and click Delete. A dialog box appears. Click OK to continue with the deletion or click Cancel
to cancel the operation.

• Print. When the report is displayed, select File→Print from the browser menu to print the report.

NOTE: Because certain print options are not supported in HP Systems Insight Manager, you cannot:

• Change the Orientation to Landscape in the Print dialog box (see Printing Problems in the
Troubleshooting section of HP Systems Insight Manager Technical Reference Guide for a workaround
to this issue)

• Cancel printing after the print job has been executed, but you can access the operating systems
print queue and cancel the print job

• Print to a file
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• Print selected systems, only entire list of systems

• Print the system table view page if you close the browser immediately after issuing a print request

Buttons are disabled if you do not have appropriate rights. However, the Print button appears for all users.
Related topics

• Overview

• HP BladeSystem page

• Navigating the icon view page

• Navigating the tree view page

Navigating the picture view page
The Picture View page displays a consolidated picture of all discovered racks and enclosures included in
the All Racks, All c-Class Enclosures, All e-Class Enclosures and All p-Class Enclosures collections. To access
the picture view, navigate to All e-Class Enclosures and select an enclosure. The enclosure appears in
picture view by default.

NOTE: The HP BladeSystem collection does not provide the picture view option.

Viewing details
To view details about p-Class, e-Class, or c-Class systems that support SNMP or HTTP, position your cursor
over the system and a tool tip displays.

NOTE: If the system does not support SNMP or HTTP query, Not Available appears.

Tool tips are available for the following:

• p-Class servers

• p-Class switches

• c-Class servers

• c-Class switches

• e-Class servers
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• e-Class switches

• Bare metal blades

p-Class servers
The picture view tool tip displays the following information for servers:

• Bay

• Name

• IP Address

• Serial Number

• Model

• Operating System

• System ROM Version

• Insight Management Version

• Management Processor IP

• Management Processor Firmware Version

• The following details appear in the tool tip if the blade is hosting Virtual Machines:

VM Host Environment
Note: VM Host Environment details are shown for Virtual Machine Hosts running the following
operating systems:

•

• VMWare ESX

• VMWare GSX

• Microsoft Virtual Server (MSVS)

• HPVMs for HP-UX

• VM Guest Count

p-Class switches
The picture view tool tip displays the following information for switches:

• Bay

• Name

• IP Address

• Serial Number

• Model

• Firmware Version

c-Class servers
The picture view tool tip displays the following information for c-Class servers:

NOTE: Mezzanine system information is displayed only for c-Class servers. For p-Class or e-Class systems,
the Mezzanine slot labels are not shown.

• Bay

• Name

• IP Address

• Serial Number

• Model
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• Operating System

• System ROM Version

• Insight Management Version

• Management Processor IP

• Management Processor Firmware Version

• Mezzanine Slot X
Note: The X refers to the slot number of the Mezzanine card. If the c-Class server does not have any
Mezzanine cards, this option is not shown.

• Partner Device
Note:The Partner Device tool tip appears if a c-Class blade is associated with a storage device:

From this release onwards, HP ProLiant BL680c servers are also supported.

c-Class switches
The picture view tool tip displays the following information for c-Class switches:

NOTE: The c-Class tool tip does not display the Firmware Version Instead, it displays the Media Type.
The tool tip does display the Running Status for Virtual Connect Ethernet switches.

• Bay

• Name

• IP Address

• Serial Number

• Model

• Media Type

e-Class servers
The picture view tool tip displays the following information for e-Class servers:

NOTE: The e-Class server and desktop tool tip shows only the information listed below.

• Bay

• Name

• IP Address

• Serial Number

• Model

• Operating System

e-Class switches
The picture view tool tip displays the following information for e-Class switches:

• Name

• IP Address

• Serial Number

• Model

Bare metal blades
The picture view tool tip displays the following information for bare metal blades:
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NOTE: The bare metal blade tool tip shows only the information listed below. Any information in addition
to the items listed are displayed as Not Available.

NOTE: If a server is discovered by enabling Automatically discover a blade server when its Integrated
Lights-Out Management processor is identified, the only items displayed are Management Processor
Version and ROM Version.

• Bay

• Name

• Serial Number

• Model

• System ROM Version

• Management Processor IP

• Management Processor Firmware

Customizing the view
You can change the way the picture view page appears. Click the down arrow on the View as dropdown
list, and select table, icon, or picture view. However, the picture view is only available if you have already
drilled down to a rack or enclosure by clicking the rack or enclosure name on the system table view page
and then switching back to a tabular or iconic view. Drilling down into a rack or enclosure restricts the
systems to only those that pertain to the rack or enclosure. You can then switch between the other view types.
Related topics

• Overview

• HP BladeSystem page

• Navigating the icon view page

• Navigating the tree view page

HP BladeSystem page 21



22



3 Racks and enclosures
Overview

A blade server is typically a very dense server system containing microprocessors, memory, and network
connections that can be easily inserted into a rack-mountable enclosure to share power supplies, fans,
switches, and other components with other server blades. Server blades tend to be more cost-efficient, faster
to deploy, and easier to adapt to growth and change than traditional rack-mounted or tower servers.
A rack represents the actual physical rack as it appears in the lab, and you can create it manually in HP
BladeSystem Integrated Manager. See “Viewing enclosures” for more information. An enclosure is a physical
container for a set of blades servers. It consists of a backplane that routes power and communication signals
and additional hardware for cabling and thermal issues. It also hosts the CPU or server power supplies. A
rack is a container for an enclosure although racks and enclosures are considered containers.
HP BladeSystem Integrated Manager in HP Systems Insight Manager provides the following collection types:

• e-Class e-Class collections include the Consolidated Client Infrastructure blade PC Enclosures which
host 20 PC blades including bc1000/bc1500 and bc2000/bc2500 PC blade types, and the e-Class
BL10e server blades.

• p-Class p-Class enclosures together form a rack if a set of enclosures are networked in the hardware
level. A p-class enclosure hosts the ProLiant BL p-Class server and workstation types.

• c-Class c-Class collections consist of the HP BladeSystem c7000 and c3000 Enclosures, HP ProLiant
BL c-Class server blades, network interconnect components, Onboard Administrator, and management
tools that enable adaptive computing, optimized for rapid deployment.

IMPORTANT: When upgrading from HP BladeSystem Integrated Manager 2.3 or earlier to HP BladeSystem
Integrated Manager 3.0 or later, any user-defined collections relating to the All p-Class racks or All c-Class
racks are lost. After upgrading, the default All c-Class racks and All p-Class racks collections appear in the
All Racks collection provided that the devices are not re-identified.

Rack and enclosure collections
HP Systems Insight Manager (HP SIM) discovers and identifies server blade and enclosures.
There are two specific search criteria for enclosures:

• Rack

• Enclosure

Running searches using these criteria returns a list of systems contained in the selected racks or enclosures.
Any criteria, except for the two listed previously, returns the racks and enclosures themselves, not the systems
in those racks and enclosures. For instance, a system name search for the rack Franklin 1 would return
the system Franklin 1, not any systems in Franklin 1.
Two default collections are related to racks and enclosures and are listed under the System Type collection:

• All Racks

• All Enclosures

On the system table view page, racks display in two formats:

• Encl1 in Rack1

• Rack1

The Picture View page can be displayed by clicking rack hyperlink.
Clicking an enclosure name in the System Name column on the system table view page produces a list of
all discovered systems in the selected enclosure. The status for both racks and enclosures is always Unknown.
The Picture View page displays if the server is part of an enclosure or rack. This page contains a diagram
of the discovered systems in the enclosure and, if available, in the rack. While signed in to HP SIM and
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placing your cursor over a server shown in the view, you receive information on that particular server,
including server blade name, slot number, and the enclosure in which the server is located.

NOTE: The picture view for a c-class enclosure is enhanced to display a link to access the virtual domain.

Related procedures

• Viewing e-Class enclosures

• Viewing c-Class enclosures

• Viewing p-Class enclosures

Related topics

• Navigating the System(s) tab

• Navigating the Events tab

• Overview

• HP BladeSystem page

• Navigating the picture view page

• Navigating the tree view page

Viewing racks
To view a created rack, click All Racks from the System and Event Collections panel. All of the created
racks are listed. Select the rack that you want to view additional details. By default, the picture view of the
rack is displayed. The picture view of the rack also distinguishes the blades that are running Virtual Machines
(VMs) on them. When you move your mouse over the image of the rack, these details are displayed. In
addition, it also displays the number of VMs that are running.

NOTE: For c-Class devices (blades and switches in an enclosure) to appear in HP BladeSystem Integrated
Manager tree or picture view, at least one Onboard Administrator in that enclosure must be discovered
before or after the devices. The devices may be discovered in HP SIM but do not appear in HP BladeSystem
Integrated Manager tree or picture view if none of the Onboard Administrators are discovered.

NOTE: Any change in the physical configuration of the c-Class enclosure, such as moving the devices from
one slot to another or removing a device, requires re-identification of the Onboard Administrator.

The Rack View page displays the following tabs:

• “Navigating the System(s) tab”
Note: The System(s) tab displays in picture view when the Rack View page is accessed.

• “Navigating the Events tab”

Related procedures

• Viewing p-Class enclosures

• Viewing c-Class enclosures

• Viewing e-Class enclosures

• Onboard Administrator links

Related topics

• Overview

• HP BladeSystem page

• Viewing enclosures
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• Navigating the tree view page

• Navigating the table view page

• Navigating the icon view page

• Navigating the picture view page

Viewing enclosures
The picture view page for enclosures contains a diagram of the discovered systems in the enclosure if
available. The enclosure name appears along with a picture view, table view, or iconic view of the enclosure.
While signed in to HP Systems Insight Manager (HP SIM), placing your cursor over a server shown in the
view, displays information on that particular server, including server blade name, slot number, and the
enclosure in which the server is located. You can also click a server name to display information about the
server. The System Page appears.

The following systems are displayed in the picture view for racks and enclosures:

• Servers, desktops and workstation blades

• Interconnect modules

• Power supply enclosure
Note: Provided for p-Class only.

• Onboard Administrator, fans, and power units
Note: Provided for c-Class only.

Slots that have no server or desktop identified and no interconnect switch identified are also displayed in
the picture view for enclosures.
The following sections are displayed in the picture view for racks and enclosures:

• System Status

Health Status icon. Represents the health of a system including Critical, Major, Minor, or Normal.•

• Identification

Enclosure Name. Displays the name of the enclosure. You can click Printable Enclosure Details
to display a printable table that includes the following enclosure details:

•

• Bay

• System Name

• IP Address

• Model

• Firmware Version

• Role
The following details are shown for the Onboard Administrators:

• Bay

• System Name

• IP Address

• Model

• Firmware Version

• Role

The following details are shown for servers:

• Bay

• System Name

• IP Address
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• Model

• Management Processor IP

• Management Processor Firmware Version

• Insight Management Agent Version

• System ROM Version

• Operating System

• Serial Number. Displays the serial number of the enclosure.

• UUID. A unique identifier from the agent or other instrumentation on the system.

• Rack Name. Click to display the rack in picture view.

• Unit ID (LED). Indicates whether the Unit ID is on or off.

• Onboard Administrator - Click the Onboard Administrator link to display the Onboard Administrator
home page.
Note: The Onboard Administrator link appears only for c-Class enclosures.

• Virtual Connect Manager. Displays the IP address to the Virtual Connect Manager (VCM). You
can click the IP address to access the VCM system.
Note: This option appears only when a Virtual Connect is available.

• VCM Domain Name. Displays the VCM domain name. Click the domain name to view the System
page of the VC Domain.

• For c-Class enclosures:

Power and Thermal section•

• Power Redundancy. Displays Power Redundancy status. Click Power Redundancy to
display the Onboard Administrator home page.

• Fan Redundancy. Displays Fan Redundancy status. Click Fan Redundancy to display the
Onboard Administrator home page.

• Enclosure Ambient Temperature. Displays the following:

Status. Displays the current status in icon form.•

• C/F. Displays the current temperature in degrees Celsius and Fahrenheit.

• Graph. Displays a graph depicting the temperature.

• The following information displays for each power unit present in the enclosure:

• Bay Number. Displays the number assigned to the bay.

• Firmware Revision. Displays the firmware revision number.

• A/C Input. Indicates the health status of the power unit.

• Phase. Displays the phase.

• Serial Number. Displays the serial number of the power unit.

• Part Number. Displays the part number for the power unit.

• Power Consumption. Displays the power consumption in watts to include:

• Output/Capacity. Displays the current output verses the capacity.

• Graph. Displays a graph depicting the output verses the capacity.

• Fans section

Bay. Displays the bay number.•

• Health Status. Displays the health status of the enclosure.

• Part Number. Displays the part number for the fan.
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• Power Used (Watts). Displays the amount of watts currently used.

• Speed (RPM). Displays the current speed in RPMs.

NOTE: From this page, you can also view the enclosure details in a separate window. Select the
enclosure name on the page and click Printable Enclosure details. A new window displays the details
of the enclosure.

• For p-Class enclosures:

Power and Thermal section
The following items are displayed on the Enclosure View for a Power Enclosure if at least one
iLO in the rack using that power enclosure has firmware version of 1.80 or higher.

•

• Load Balanced Cable. Indicates whether the load balanced cable is present.

• Power Redundancy. Displays Power Redundancy status.

• Temperature A. Displays overall temperature in the left section of the power enclosure.

• Center Temperature. Displays overall temperature in the center section of the power
enclosure.

• Temperature B. Displays overall temperature in the right section of the power enclosure.

• The following information displays for each power unit present in the enclosure:

• Bay Number. Displays the number assigned to the bay.

• Firmware Revision Displays the firmware revision number.

• A/C Input. Indicates the health status of the power unit.

• Input Temperature. Displays the following:

Status. Displays the status of the input temperature.•

• C/F. Displays the current temperature in degrees Celsius and Fahrenheit.

• Graph. Displays a graph depicting the Trip temperature verses Fail temperature.

• Output Temperature. Displays the following:

• Status. Displays the status of the output temperature.

• C/F. Displays the current temperature in degrees Celsius and Fahrenheit.

• Graph. Displays a graph depicting the Trip temperature verses Fail temperature.

While logged in to HP BladeSystem Integrated Manager in HP Systems Insight Manager placing your cursor
over a component shown in the view, displays information on that particular component, including slot
number/bay number, server blade name/IP address, product model, and the enclosure in which the server
is located. If the bay is empty it displays it as an empty bay. If the Firmware of the power enclosure is less
than 1.80, a question mark is displayed for each bay of the enclosure. When the cursor is moved over that
bay, it suggests to upgrade the Firmware. You can click a component in the picture view to display information
about that component. The System Page appears. See “System page” for more information. However, if
you click the status icon that is displayed on the component in the picture view, you remain on the Enclosure
View page.
There are three buttons at the bottom of the picture view page are available to users with full configuration
rights.

• Save As Collection. When a system or group of systems is selected, this button is used to save the
selection with a new name. Changes are saved on a per-user.

• Delete. This button is used to delete one or more systems from the database. Select the systems to be
deleted, and click Delete. A dialog box appears. Click OK to continue with the deletion or click Cancel
to cancel the operation. The picture view is refreshed.
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NOTE: Only systems can be deleted from the picture view. If a collection is selected, the Delete
button becomes disabled. Collections must be deleted through the Customize Collections page.

NOTE: If a VM Host is deleted, it can still be accessed through the Virtual Machine Management
Pack console, and the operations that can be performed on a VM Host are not affected by the deletion
of the HP Systems Insight Manager (HP SIM) system. The Virtual Machine Management Pack console
continues to show the HP SIM status.

NOTE: If you select a collection by checking Select "collection name" collection itself, the Delete
button is disabled. To delete collections, go to the Customize Collections page.

• Print. Click Print to display a printable version of the picture. Print the picture from the browser by
clicking File→Print.

Print is available regardless of your rights, however the other options are only enabled if you have
appropriate rights.

Viewing an enclosure
To view an enclosure or power enclosure, click an enclosure collection in picture view or click Enclosure
Name in the Rack view. The Enclosure View page is displayed in picture view. The picture view page for
enclosures contains an image of the discovered enclosure with the discovered servers residing in the enclosure.

Creating a rack
When HP Systems Insight Manager (HP SIM) discovers devices with rack information such as iLO or OA,
enclosures and racks are created. You can edit these racks using the rack view. The racks that you created
in the previous release are all available under the All Racks option. You can add the enclosure to these
previously created racks or you can create new racks and add enclosures to it. After you create these racks,
they are listed under the All Racks option. The options All p-class Racks and All e-Class Racks options are
no longer available.
To create a rack:
Except for e-class racks, all other racks are automatically created when they are discovered. To add an
e-class enclosure to a rack, use the following procedure.
1. To access the picture view, navigate to All e-Class Enclosures, All c-Class Enclosures or All

p-Class Enclosures.
2. Click an enclosure. The enclosure picture view appears.

Note: In an enclosure under the Identification section, if the Rack name displays Not Available then
the enclosure is not included in any rack.

3. To add the enclosure to a new rack, click Add Enclosure to a rack. The Add to rack dropdown list
appears.
Note: This option is only available if an enclosure is not associated with a rack.

4. Select Add to new rack from the Add to Rack dropdown list and click GO. The Edit Rack page
appears. When a new rack is created from an enclosure view, the enclosure is automatically added to
the Selected enclosures section.
Note: The Add to Rack dropdown list also lists the racks that were previously created. To add an
enclosure to an existing rack, select the rack name and click GO.
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5. To create a rack, you must add the following details:

• Rack Name. Enter a name for the new rack and select the rack type from the dropdown list.
You can use this rack name to search for the rack later. This is a required field.

NOTE: The name you enter for the rack can differ from the rack name maintained by the enclosure
or the management processor.

• Rack Height. Select the height of the rack from the dropdown list.

• Data Center ID. Enter an ID for the data center. This ID can be alpha numeric and can include
hypens and underscores (- and _) only.

• Data Center Location Enter the location of the data center. It can be the geographic location or
the actual physical location of the data center.

• Row Number. Enter the row number where the enclosure is located. You can enter only numerals
for this field.

• Position in Row. Enter the position in the row where the enclosure is located. You can enter only
numerals for this field.

Note: If you are adding an enclosure to an existing rack, these details are automatically populated.
Note: In earlier versions, when you added an enclosure to a rack, you could specify a unique name for
the rack. This rack name could be different from the rack name that the enclosure maintained.

6. From the Available Enclosures dropdown list, select the filter by which you want to view the list of
enclosures. You can select All Enclosures or Class. You can filter the collection by entering a class.
For example, if you enter p-Class, then all p-Class enclosures are available to be added to the rack.
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7. Select one or more of the relevant enclosures and click the >> symbol to add them to the rack. You can
click << to remove enclosures from the rack. You can also drag and drop the enclosure in the desired
position within the rack.

Note: indicates enclosures which are daisy chained.

8. Click Save. The enclosure is added to the rack and the picture of the new rack with the added enclosure
appears. If an enclosure has already been added to another rack, a message appears indicating the
enclosure is already assigned to another rack. You can confirm your intention to remove the enclosure
from the existing rack and it is added to the new rack. You can click Cancel to discard the rack and
close the window.

Editing a rack
From the picture view of a rack, you can edit the rack to add or remove enclosures.
To edit a rack:
1. To access the picture view, navigate to All Racks and select the rack to be edited and click Edit Rack.

The Rack View page appears.
Note: The rack can be edited and deleted only from the picture view.

2. To edit a rack, you can change any of the following details:

• Rack Name. Enter a name for the new rack and select the rack type from the dropdown list.
You can use this rack name to search for the rack later.

• Rack Height. Select the height of the rack from the dropdown list.

• Data Center ID. Enter the data center ID. This ID can be alpha numeric and can include hypens
and underscores (- and _) only.

• Data Center Location Enter the data center location. It can be the geographic location or the
actual physical location of the data center.

• Row Number. Enter the row number where the enclosure is located. You can enter only numerals
for this field.

• Position in Row. Enter the position in the row where the enclosure is located. You can enter only
numerals for this field.

3. From the Available Enclosures dropdown list, select the filter by which you want to view the list of
enclosures. You can select All Enclosures or Class.

4. Select one or more of the relevant enclosures and click the >> symbol to add them to the rack. You can
click << to remove enclosures from the rack.

Note: indicates enclosures which are daisy chained.

5. Click Save. The enclosure is added to the rack and the picture of the new rack with the added enclosure
appears. If an enclosure has already been added to another rack, a message appears indicating the
enclosure is already assigned to another rack. You can confirm your intention to remove the enclosure
from the existing rack and it is added to the new rack.

Saving an Onboard Administrator configuration
You can save the current settings of a c-Class enclosure as a configuration script. After you save this
configuration file, you can always upload this configuration script using the Onboard Administrator to revert
to the previous settings of the enclosure. When you save a configuration file, you must provide a file name
that is unique to that enclosure. Also, you can save multiple configuration scripts for a single c-Class enclosure.
To save a c-Class enclosure configuration:
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1. From the Tools and Links page of the Onboard Administrator, click Save/Restore Configuration
of Onboard Administrator.
Note: You can access this option from Save or Restore Onboard Administrator settings in the
Configure section.

2. Enter the user name and password for the Onboard Administrator. The Save/Restore Configuration
Script page appears.

3. Enter a unique name for the configuration script and click Save. The name must meet the following
conditions:

• Alphanumeric and can contain special characters such as underscores and periods.

• Must start with an alphabet character.

The configuration script is listed in the Restore Configuration section.

Restoring an Onboard Administrator configuration
You can restore the previous settings of an enclosure by selecting the respective configuration script that you
had saved earlier.
To restore a c-Class enclosure configuration:
1. From the Tools and Links page of the enclosure, click Save/Restore Configuration of Onboard

Administrator.
2. Enter the user name and password for the Onboard Administrator. The Save/Restore Configuration

Script page appears.
3. In the Restore Configuration section, select the file that includes the configuration settings that you

want to restore.
4. Click Restore. The settings of the enclosure are restored.

Deleting a configuration script
You can delete a configuration script.
To delete a c-Class enclosure configuration:
1. From the Tools and Links page of the enclosure, click Save restore OA configuration and select

the configuration script to be deleted and click Delete.
Note: You can select multiple configurations and delete them simultaneously.

2. Click Back from the browser to navigate to the Tools/Links page of the Onboard Administrator.
Related topics

• Overview

• HP BladeSystem page

• Viewing e-Class enclosures

• Navigating the tree view page

Viewing p-Class enclosures
p-Class enclosures together form a rack if a set of enclosures are networked in the hardware level. A p-class
enclosure hosts the ProLiant BLp Class server types.
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To view a p-Class enclosure:
1. From the HP Systems Insight Manager Home page, expand the HP BladeSystem collection in the

Systems and Events panel.
2. Expand the All p-Class Enclosures. The p-Class enclosures tree expands.
3. Expand the rack that includes the enclosure you want to view.
4. Click the enclosure name that you want to view. The enclosure appears in the Enclosure View page.

Note: The p-Class power enclosure and power redundancy information appears only when the firmware
of at least one of the iLO's is greater or equal to 1.82.

5. To change the view from the tree view default, select table or icons from the View as dropdown list.
The page reappears displaying the new view.

Related topics

• Overview

• HP BladeSystem page

• Navigating the tree view page

• Viewing p-Class enclosures

Viewing e-Class enclosures
The e-Class collections include the Consolidated Client Infrastructure blade PC Enclosures which host 20 PC
blades including bc1000/bc1500 PC blade types, and the e-Class BL10e server blades.
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To access all e-Class Enclosures:
1. From the HP Systems Insight Manager Home page, expand the HP BladeSystem collection in the

Systems and Events panel.
2. Expand the All e-Class Enclosures collection. The All e-Class Enclosures tree expands.
3. Click the enclosure name that you want to view. The enclosure appears in the Enclosure View page.
4. To change the view from the tree view default, select table or icons from the View as dropdown list.

The page reappears displaying the new view.
Related topics

• Overview

• HP BladeSystem page

• Navigating the tree view page

• Viewing e-Class enclosures

Viewing c-Class enclosures
c-Class collections consist of the HP BladeSystem c7000 and c3000 Enclosures, HP ProLiant BL c-Class server
blades, network interconnect components, Onboard Administrator, and management tools that enable
adaptive computing, optimized for rapid deployment.

To view a c-Class enclosure:
1. From the HP Systems Insight Manager Home page, click All c-Class Enclosures in the Systems and

Events panel. You can also expand the toggling expansion control to expand the c-Class Enclosures
collection. The c-Class and enclosures appear.

NOTE: In addition to displaying details such as servers, storage, the picture view of the c-class
enclosures also shows the PCI expansion blade that is associated with the enclosure.

2. Click on the enclosure that you want to view. The Enclosure View page appears.
3. To change the view from the tree view default, select table or icons from the View as dropdown list.

The page reappears displaying the new view.
To view a c3000 class enclosure:
1. From the HP Systems Insight Manager Home page, click All c-Class Enclosures in the Systems and

Events panel. You can also expand the toggling expansion control to expand the c-Class Enclosures
collection. The c-Class and enclosures appear.

2. Click on the enclosure that you want to view. The Enclosure View page appears.
3. To change the view from the tree view default, select table or icons from the View as dropdown list.

The page reappears displaying the new view.
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Starting with this release, you can view the DVD connection status of the c-class c3000 and c3000 Tower
model enclosures. The picture view of the enclosure displays the DVD image for the enclosure. Click on the
DVD image of the enclosure to log in to the Onboard Administrator and view the connection status.
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NOTE: The c3000 class enclosures are supported by the Onboard Administrator with the firmware version
2.00.

NOTE: Redundant Onboard Adminstrator is not supported in c3000 enclosure.

NOTE: If the enclosure is managed by Virtual Connect Manager, the picture view also displays the Virtual
Connect Domain name and the IP address.

Related topics

• Overview

• HP BladeSystem page

• Navigating the tree view page

• Viewing c-Class enclosures

Navigating the System(s) tab
The picture view page for racks and enclosures contains a picture view of the discovered systems in the rack
or enclosure if available. The rack name appears along with a picture view, table view, or iconic view of
the rack. While signed in to HP Systems Insight Manager (HP SIM), placing your cursor over a server shown
in the view, displays information on that particular server, including server blade name, slot number, and
the enclosure in which the server is located. You can also click a component name to display detailed
information about the component. The System Page appears.
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The following items are listed on the Rack View page.

• Rack name in header. Displays the name of the rack.

• Updated: (Timestamp). Automatically refreshes and displays the last updated timestamp.
Note: This reflects the Central Management Server time and not the client time.

• Type of system in parentheses (rack). Displays the system type of in parenthesis.

• Help link. Click the help link, which is displayed as a question mark, to view the online help.

• View as dropdown list. Select from the following views:

Table. See “Navigating the table view page” for more information.•

• Tree. See “Navigating the tree view page” for more information.

• Icons. See “Navigating the icon view page” for more information.

• Picture. See “Navigating the picture view page” for more information.

• Multi-select checkboxes. Select the device type based on the following:

All Blades•

• All Interconnect Switches

• All Onboard Administrators

• All Enclosures
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• Front and rear views. Displays realistic front and rear picture views which include:

A collapsible tray for each enclosure in the rack, with the enclosure status and name in the title
bar

•

• Selection checkboxes on all selectable items

• Status icons on all items with status

• Each blade or switch hyperlinks to that system's System Page

• Enclosure details. Enclosure details to the right of the pictures include:

Enclosure Name. Click Enclosure Name to display the picture view of the enclosure.•

• Serial number. Displays the serial number of the system.

• Rack name. Displays the name of the rack.

• Unit ID (LED). Indicates whether the Unit ID is on or off.

• Health Status. Indicates the health status of the enclosure.

• Data Center ID. Indicates the identification number of the data center which the rack is part of.

• Data Center Location. Indicates the location of the data center which the rack is part of.

• Row Number. Indicates the row number of the rack.

• Position in Row. Indicates the position of the rack in the row.

The details such as Data Center ID, Data Center Location, Row Number and Position in Row are visible
only when you create a new rack or when you edit an existing rack.
The following details are shown for only c-Class enclosures:

• Onboard Administrator. Displays a link to the Onboard Administrator home page.

• Virtual Connect Manager. Displays the IP address to the Virtual Connect Manager (VCM). You
can click the IP address to access the VCM system.

• VCM Domain Name. Displays the VCM domain name. Click the domain name to view the Systems
page for the VC Domain.

• Firmware Revision. Displays the firmware revision number.
Note: This option is available for only p-Class collections.

• Power zone. Displays the power zone that the rack where the rack is located. An alert is displayed
if the power condition has changed. For example, an alert displays if an administrator removes
a power supply from an enclosure.
Note: This option is available for only p-Class collections.

• Temperature C/F. Displays the current temperature of the enclosure in degrees Celsius and
Fahrenheit.
Note: This option is available for only p-Class collections.

• Fan Redundancy. Displays Fan Redundancy status. Click Fan Redundancy to display the
Onboard Administrator home page.
Note: This option is available for only c-Class collections.

• Power Redundancy. Click Power Redundancy to display the Onboard Administrator home
page.
Note: This option is available for only c-Class collections.

• For power enclosures, the following additional information appears:

Load Balanced Cable. Indicates whether the load balanced cable is present.•

• Power Redundancy. Displays the Power Redundancy information for the enclosure only if the
iLO has firmware version 1.82 or later.
Note: This option is available for only p-Class collections.
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NOTE: The enclosure is highlighted if at least one iLO in the rack using that power enclosure has
firmware version of 1.82 or higher.

While logged in to HP BladeSystem Integrated Manager in HP Systems Insight Manager, placing your cursor
over a component shown in the view, displays information on that particular component, including slot
number/bay number, blade server name/IP address, product model, and the enclosure in which the server
is located. If the bay is empty it displays as an empty bay. If the Firmware of the power enclosure is less
than 1.80, a question mark is displayed for each bay of the enclosure. When the cursor is moved over that
bay, it suggests to upgrade the Firmware to 1.80 or higher. You can also click a component to display
information about that component. The System Page appears. See “System page” for more information.

System List buttons
Three buttons at the bottom of the System(s) tab (picture view) are available to users with
full-configuration-rights.

• Save As Collection. When a system is highlighted, this button is used to save the selection with a
new name. Changes are saved on a per-user, per-collection basis.

• Delete. This button is used to delete one or more systems from the database. Select the systems to be
deleted, and click Delete. A dialog box appears. Click OK to continue with the deletion or click Cancel
to cancel the operation.

• Print. When the report is displayed, select File→Print from the browser menu to print the report.

NOTE: Because certain print options are not supported in HP Systems Insight Manager, you cannot:

• Change the Orientation to Landscape in the Print dialog box (see Printing Problems in the
Troubleshooting section of HP Systems Insight Manager Technical Reference Guide for a workaround
to this issue)

• Cancel printing after the print job has been executed, but you can access the operating systems
print queue and cancel the print job

• Print to a file

• Print selected systems, only entire list of systems

• Print the system table view page if you close the browser immediately after issuing a print request

Buttons are disabled if you do not have appropriate rights. However, the Print button appears for all users.

Save a collection
You can save a collection with a new name or to a specific location.
To save a collection:
1. In the Name field, enter a name for the collection.
2. Under Place in Folder, select where to save the collection (in a Private folder of one of the Shared

folders).
3. Click OK to save the collection, or click Cancel to cancel the save operation.

Deleting a Blade system
You can delete a Blade system from a rack.
1. On the system tab (picture view), select one or more systems to delete from the rack or enclosure by

selecting the checkbox associated with the system in the image displayed.
2. Click Delete. A dialog box appears, stating, Are you sure you want to delete these

systems?

3. Click OK to delete the systems, or click Cancel to return to the system tab (picture view) without deleting
the systems.
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NOTE: Containers (for example, racks) must be empty before they can be deleted. Selecting a rack and
all its contained systems works without error.

Related topics

• Viewing racks

• Overview

• Navigating the Performance/Utilization tab

• Navigating the Event tab

• Navigating the Tools and Links tab

Navigating the Events tab
The Events tab for c-Class racks or enclosures displays all current device events in the enclosure or rack in
table view.
The event table view page is divided into the following sections:
1. Filter Criteria
2. Event Status Legend
3. Event Collection Columns
4. Event Details
5. Event Management Buttons

From this page, you can clear, delete, and assign events, enter comments on the event, and view printable
reports.

Filter Criteria
The Event list can be filtered using the Filter Criteria dropdown list to view individual systems, such as
blades, switches or Onboard Administrator events, separately or you can view all events.
To filter the Event list:
1. From the Filter Criteria dropdown list, select a criteria:

• All Onboard Administrator Events Events that are reported by all Onboard Administrators
included in the selected rack or enclosure. This option is only available for c-Class racks or
enclosures.

• All Blade Events Events that are reported by all blades included in the selected rack or enclosure.
This option is available for e-Class enclosures as well as p-Class and c-Class racks or enclosures.
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• All Switch Events Events that are reported by all switches included in the selected rack or
enclosure. This option is available for p-Class and c-Class racks or enclosures.

• All Events Events that are exposed by all devices in the selected rack or enclosure. This option
is available for p-Class and c-Class racks or enclosures.

2. Click View. The filtered Event list appears.

Event Status Legend
The legend shows how many events in the view are Critical, Major, Minor, Normal, and Informational.

Event Details
The event collection can be displayed by clicking:

• An event collection from the Systems and Events panel

• An event status icon in the System Status panel

• The All Events Associated with this System link from the System Page

• A private event collection

• A hyperlink in the Uncleared Events section on the System Overview page

Event collections are filtered based on authorizations. Users can only view events on systems for which they
have the appropriate authorization.
When HP Storage Essentials is installed, a link in this section allows you to view the corresponding event
details in HP Storage Essentials.

Event Collection Columns
Sort collection results by a particular column, click the column header for ascending or descending order.
Place your cursor over a column name for a brief description of the column.
The following columns are displayed:

• Selection

• State

• Severity

• Event Type

• System Name

• Event Time

• Assigned To

• Comments

• System Type

• Rack Name

• Enclosure Name

Selection
Select the checkbox in this column to select an event. You can select more than one event. Select the checkbox
in the column heading to select or deselect all displayed events.

State
This column displays whether the event is in the Cleared or Not Cleared state. Events start in the Not Cleared
state. A Cleared state means the user is no longer interested in this event. Event states also include In Progress,
indicating not all the data for the event has been logged. Events in an In Progress state cannot be removed
or cleared. A restart of the HP SIM CMS moves any pending state events to Not Cleared.
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Severity
This column displays the event status icon to indicate the severity of a problem represented by the event.

Event Type
This column displays the type of an event. Some examples are SNMP traps, login failures, or the replicate
agent settings too. Select an event type from the list to view the Event Details section. The information
displayed varies depending on the event. If you cannot see the entire event type in the column, place your
cursor over this field, and a popup window is displayed that shows the entire event type name.

System Name
This column displays the name of the system on which the event occurred. Clicking a link in this column
displays the System Page for the selected system.
When an event occurs that affects an entire rack or enclosure, it is possible for several systems in that rack
or enclosure to generate a trap for that event. These container traps are filtered such that only one event is
logged per rack or enclosure trap. Also, even though the source of the trap may be a blade server or
management processor, HP Systems Insight Manager sets the Event Source and Associated System for
the logged event to the rack or enclosure, as appropriate.

Event Time
This column displays the time stamp when the HP SIM CMS received this event, which includes the date and
time. If the system is in a different time zone than the event time (CMS time), the event time is converted to
the system time zone.

Assigned To
To assign responsibility for an event to a user, select the event, and click Assign to at the bottom of the
page. The Assign to section appears, which enables you to select to assign a new assignee or use an
existing assignee. If you select to use an existing assignee, you can only select one user name from the list.
This name does not have to be a user with privileges on the system or a name that can be used to log into
the CMS. This field is free-form text.

Comments
This column either displays any existing comments for this event or is blank if no comments have been entered.
Comments are truncated in the column itself. Click the event type to view the entire comment if needed, or
place your cursor over a comment field, causing a pop-up window that shows the entire comment to appear.

System Type
This column displays system types such as enclosure or rack.

Rack Name
This column displays the name of the rack.

NOTE: This column displays when the system is a rack or enclosure.

Enclosure Name
This column displays the name of the enclosure.

Navigating the Events tab 41



NOTE: This column displays when the system is a rack or enclosure.

Event Management Buttons
Five buttons at the bottom of the event table view page are available to users with full-configuration-rights
only. These buttons might not appear depending on where you access this page from. For example, when
creating a task and selecting targets, there are no buttons displayed, only the table or system names.

• Clear. This button is used to clear one or more events from the database. Select the events to clear,
and click Clear.

• Delete. This button is used to delete one or more events from the database. Select the events to be
deleted, and then click Delete. A dialog box appears. Click OK to continue with the deletion, or click
Cancel to cancel the deletion.

• Assign to. This button is used to assign responsibility for events to a particular user.

• Enter Comments. Brings up a dialog box to enter comments for one or more events.

• Print. When the report is displayed, select File→Print from the browser menu to print the report.

Buttons are disabled if you do not have appropriate privileges. However, the print button is displayed for
all users.
Related procedures

• Navigating the System tab

• Navigating the Performance/Utilization tab

• Navigating the Tools and Links tab

Related topics

• Overview

• System page
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4 System page
The System Page is used to display information that is related to a specific system. This page displays:

• System Tab. Includes general system and status information. See “Navigating the System tab” for
more information.

• Tools & Links Tab. Includes links to System Management pages, HP Systems Insight Manager pages,
and other tools and information. See “Navigating the Tools and Links tab” for more information.

• Events Tab. Displays the event table view page for the system. See “Navigating the Event tab” for
more information.

• Performance/Utilization Tab. Includes general information about the performance of the system. See
“Navigating the Performance/Utilization tab” for more information.

• Port Mapping/Mezzanine Cards Tab. Displays port mappings for c-Class blades and switches. See
“Navigating the Port Mapping/Mezzanine Cards tab” for more information.
Note: This tab appears only for c-Class collections.

• Essentials Tab. Displays a description of the available software and a link to the HP web site where
you can get further details. Only full and limited configuration rights users can view the Essentials tab.

There are two ways to access the System Page:

• Click Tools→System Information→System Page. Then select target systems.

• Click the system name in the System Name column on the system table view page.

Related topics

• Navigating the System tab

• Navigating the Tools and Links tab

• Navigating the Event tab

• Navigating the Performance/Utilization tab

• Overview

• Viewing e-Class enclosures

Navigating the System tab
Role

This section indicates whether the Onboard Administrator is active or inactive.

Virtual Connect Domains
This option displays the following information of the Virtual Connect Domain:

• Virtual Connect Domain Name

• Primary Virtual Connect Ethernet Module

• Configuration Status

• Rack Name

• Firmware Version

• Enclosure

• Interconnect Bay
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To access the All Virtual Connect Domain discovered in your system, go to the and Events panel, click
Shared Systems by Type and All Virtual Connect Domains. The All Virtual Connect Domain option is
visible in the left navigation pane when the Onboard Administrator is discovered.

NOTE: There is a different system page for Virtual Connect Domain and Master Virtual Connect Switch.

Related topics

• Overview

• Navigating the Performance/Utilization tab
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• Navigating the Event tab

• Navigating the Tools and Links tab

Navigating the Tools and Links tab
The system links that you can view depend on the Discovery configuration, the correct installation of agents
and protocols, and the Polling Tasks that interrogate the system. The Tools & Links page includes:

• “System Management Pages”

• “System Web Application Pages”

• “HP Systems Insight Manager Pages”

System Management Pages
This section includes the links that are provided by the HTTP Web Management on the system. These links
are for system management and status. If the system does not have Insight Management Agent, this section
is not displayed. Some of the available links include:

• HP Version Control Agent

• HP Version Control Repository Manager

• Insight Management Agent

System Web Application Pages
This section includes a list of Web applications hosted by the system. Some of the available links include:

• VMware Management Interface

• Default Web Server

• HP Systems Insight Manager

HP Systems Insight Manager Pages
This section contains links that are generated by HP Systems Insight Manager. Some of the available links
include:

• The Data Collection Report link displays the data collection report for the system in a separate report
results window.

• The System Protocol Settings link points to the Protocol Settings, where you can set the protocol
settings for this individual system only.

• The Edit System Properties link enables users with full-configuration-rights to re-configure some of
the system properties for a single system through its system page. This link is not available if you do
not have full-configuration-rights.

• The Suspend/Resume Monitoring link enables you to set the timer for suspending monitoring. This
allows a system to be excluded from the status polling, identification, data collection, and the automatic
event handling features of HP Systems Insight Manager. The available suspend lengths include the
pre-determined increments of 5 minutes, 15 minutes, 1 hour and 1 day. The suspend feature can be
turned on indefinitely. This link is only available to users with full-configuration-rights.

• The Save/Restore Configuration of Onboard Administrator appears for an active Onboard
Administrator.

iLO Links
This section contains links that are generated by iLO. Some of the available links include:

• The Virtual media link launches Virtual Media in a new window.

• The Remote Console link launches the Remote Console in a new window.
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• The Remote Serial link launches the Remote Serial Console in a new window.
Note: iLO firmware must be 1.30 or later. An upgrade must be followed up with a re-identification of
iLO.

• The Telnet to iLO link launches Telnet to iLO in a new window.
Note: Telnet and iLO links are not available for Integrity blades.
Note: The Telnet protocol handler is no longer supported in Internet Explorer 7. The Telnet feature will
not be available to users using Internet Explorer 7.

NOTE: These links can also be configured for Single Sign On (SSO) from HP SIM.

Complete the following steps to configure SSO to iLO2:

• Login to iLO2.

• Go to Administration->Security-> HP SIM SSO.

• Enable the Single Sign-on Trust Mode by choosing any of the options from the drop down menu.

• Click ADD HP SIM Serverand depending on the options selected in step 3, carry out one of the
following steps:

• Add a trusted HP SIM Server name.

• Retrieve and import a certificate from the trusted HP SIM server.

• Directly import an HP SIM Server certificate.

• Click Apply.

Related topics

• Overview

• System page

• Navigating the System tab

• Navigating the Performance/Utilization tab

• Navigating the Event tab

Navigating the Event tab
The Events tab for c-Class racks or enclosures displays all current device events in the enclosure or rack in
table view.
The event table view page is divided into the following sections:
1. Filter Criteria
2. Event Status Legend
3. Event Collection Columns
4. Event Details
5. Event Management Buttons
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From this page, you can clear, delete, and assign events, enter comments on the event, and view printable
reports.

Filter Criteria
The Event list can be filtered using the Filter Criteria dropdown list to view individual systems, such as
blades, switches or Onboard Administrator events, separately or you can view all events.
To filter the Event list:
1. From the Filter Criteria dropdown list, select a criteria:

• All Onboard Administrator Events Events that are reported by all Onboard Administrators
included in the selected rack or enclosure. This option is only available for c-Class racks or
enclosures.

• All Blade Events Events that are reported by all blades included in the selected rack or enclosure.
This option is available for e-Class enclosures as well as p-Class and c-Class racks or enclosures.

• All Switch Events Events that are reported by all switches included in the selected rack or
enclosure. This option is available for p-Class and c-Class racks or enclosures.

• All Events Events that are exposed by all devices in the selected rack or enclosure. This option
is available for p-Class and c-Class racks or enclosures.

2. The filtered Event list appears.

Event Status Legend
The legend shows how many events in the view are Critical, Major, Minor, Normal, and Informational.

Event Details
The event collection can be displayed by clicking:

• An event collection from the Systems and Events panel

• An event status icon in the System Status panel

• The All Events Associated with this System link from the System Page

• A private event collection

• A hyperlink in the Uncleared Events section on the System Overview page

Event collections are filtered based on authorizations. Users can only view events on systems for which they
have the appropriate authorization.
When HP Storage Essentials is installed, a link in this section allows you to view the corresponding event
details in HP Storage Essentials.
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Event Collection Columns
Sort collection results by a particular column, click the column header for ascending or descending order.
Place your cursor over a column name for a brief description of the column.
The following columns are displayed:

• Selection

• State

• Severity

• Event Type

• System Name

• Event Time

• Assigned To

• Comments

• System Type

• Rack Name

• Enclosure Name

Selection
Select the checkbox in this column to select an event. You can select more than one event. Select the checkbox
in the column heading to select or deselect all displayed events.

State
This column displays whether the event is in the Cleared or Not Cleared state. Events start in the Not Cleared
state. A Cleared state means the user is no longer interested in this event. Event states also include In Progress,
indicating not all the data for the event has been logged. Events in an In Progress state cannot be removed
or cleared. A restart of the HP SIM CMS moves any pending state events to Not Cleared.

Severity
This column displays the event status icon to indicate the severity of a problem represented by the event.

Event Type
This column displays the type of an event. Some examples are SNMP traps, login failures, or the replicate
agent settings too. Select an event type from the list to view the Event Details section. The information
displayed varies depending on the event. If you cannot see the entire event type in the column, place your
cursor over this field, and a popup window is displayed that shows the entire event type name.

System Name
This column displays the name of the system on which the event occurred. Clicking a link in this column
displays the System Page for the selected system.
When an event occurs that affects an entire rack or enclosure, it is possible for several systems in that rack
or enclosure to generate a trap for that event. These container traps are filtered such that only one event is
logged per rack or enclosure trap. Also, even though the source of the trap may be a blade server or
management processor, HP Systems Insight Manager sets the Event Source and Associated System for
the logged event to the rack or enclosure, as appropriate.

Event Time
This column displays the time stamp when the HP SIM CMS received this event, which includes the date and
time. If the system is in a different time zone than the event time (CMS time), the event time is converted to
the system time zone.
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Assigned To
To assign responsibility for an event to a user, select the event, and click Assign to at the bottom of the
page. The Assign to section appears, which enables you to select to assign a new assignee or use an
existing assignee. If you select to use an existing assignee, you can only select one user name from the list.
This name does not have to be a user with privileges on the system or a name that can be used to log into
the CMS. This field is free-form text.

Comments
This column either displays any existing comments for this event or is blank if no comments have been entered.
Comments are truncated in the column itself. Click the event type to view the entire comment if needed, or
place your cursor over a comment field, causing a pop-up window that shows the entire comment to appear.

System Type
This column displays system types such as enclosure or rack.

Rack Name
This column displays the name of the rack.

NOTE: This column displays when the system is a rack or enclosure.

Enclosure Name
This column displays the name of the enclosure.

NOTE: This column displays when the system is a rack or enclosure.

Event Management Buttons
Five buttons at the bottom of the event table view page are available to users with full-configuration-rights
only. These buttons might not appear depending on where you access this page from. For example, when
creating a task and selecting targets, there are no buttons displayed, only the table or system names.

• Clear. This button is used to clear one or more events from the database. Select the events to clear,
and click Clear.

• Delete. This button is used to delete one or more events from the database. Select the events to be
deleted, and then click Delete. A dialog box appears. Click OK to continue with the deletion, or click
Cancel to cancel the deletion.

• Assign to. This button is used to assign responsibility for events to a particular user.

• Enter Comments. Brings up a dialog box to enter comments for one or more events.

• Print. When the report is displayed, select File→Print from the browser menu to print the report.

Buttons are disabled if you do not have appropriate privileges. However, the print button is displayed for
all users.
Related procedures

• Navigating the System tab

• Navigating the Performance/Utilization tab

• Navigating the Tools and Links tab

Related topics

• Overview

• System page

Navigating the Performance/Utilization tab
The Performance/Utilization tab displays information about selected blade performance.
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NOTE: The Performance/Utilization tab is displayed for bare metal blades without any data.

The Performance/Utilization tab includes the following information:

• Updated: (Timestamp). Automatically refreshes and displays the last updated timestamp.
Note: This reflects the Central Management Server time and not the client time.

• Processor

Index. Displays the processor index number.•

• Type. Displays the processor type.

• Utilization. Displays the processor utilization.

• Logical Disk

Name. Displays the name of the logical disk.•

• Size (MB). Displays the size of the logical disk in megabytes.

• Usage (%). Displays the percentage of disk space used.

• Physical Memory

Size (MB). Displays the size of the physical memory in megabytes.•

• Free (MB). Displays the size of free physical memory in megabytes.

• Paging Size (MB). Displays the paging size in megabytes.

• Paging Free (MB). Displays the amount of free paging in megabytes.

• Server Fan

Note: The Server Fan section displays for all p-Class and e-Class blades.

• Index. Displays the index number.

• Locale. Displays the locale.

• Redundant Partner. Displays the number of the redundant partner.

• Speed. Displays the status of the server fan.

• Condition. Displays the condition of the server fan.

• Hot Plug. Displays the type of hot plug.

• Temperature

Index. Displays the index number.•

• Locale. Displays the locale.

• Celsius (C). Displays the temperature in Celsius.

• Threshold (C). Displays the threshold number.

• Condition. Displays the condition status.

• Threshold Type. Displays the threshold type status.

• Performance Management

Note: if the device is licensed for HP ProLiant Essentials Performance Management Pack, this section
displays the PMP links. Otherwise, this section displays Learn about PMP which is a link to the HP
ProLiant Essentials Performance Management Pack home page.

• Learn about PMP.... Displays a link to the HP ProLiant Essentials Performance Management Pack
home page.

Related topics

• Overview

• System page
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Navigating the Port Mapping/Mezzanine Cards tab
The PortMapping tab displays only for c-Class blades and switches.
The PortMapping tab includes the following information:

• Updated: (Timestamp) link
Note: This reflects the Central Management Server time and not the client time.

• For blades:

Mezz Slot. Displays the Mezz slot number.•

• Mezz Device. Displays the Mezz device name or No card present.

• Mezz Device port. Displays the Mezz device port name or number.

• Port Status. Displays the status of the port.

• Interconnect Bay. Displays the bay number.

• Interconnect Bay Port. Displays the bay port number.

• Device ID. Displays the device identification number.

• O.S. Interface Name. Displays the name of the network interface in the operating system.

• For switches:

Interconnect Bay Port. Displays the bay port number.•

• Port Status. Indicates the status of the port.

• Server Bay. Displays the server bay.

• Mezz Port. Displays the Mezz port number.

• For more details on the switch port mapping for this system, click here to access the Onboard
Administrator. Click Onboard Administrator to display the Onboard Administrator Home page.

Related topics

• Overview

• System page

Navigating the Essentials tab
Related topics

• Overview

• Navigating the Performance/Utilization tab

• Navigating the Event tab

• Navigating the Tools and Links tab
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5 Onboard Administrator links

NOTE: The SSO link to Onboard Administrator works only if the certificate has not expired. You can verify
the certificate expiration by accessing HP SIM Integration at the end of the tree in the Onboard Administrator
screen, and check the Valid From and Valid Until fields in the SSO certificate details. This must be in sync
with the HP SIM Central Management Server time.

NOTE: Onboard Administrator links are supported only in English on Internet Explorer 6.0 and FireFox
1.5.

To configure Onboard Administrator so the Onboard Administrator links work correctly, perform the following:
1. Launch a Telnet session to Onboard Administrator:

Telnet <OA-IP>

2. Log into the CLI using your user name and password
3. Set the SSO trust to on.
4. Download SSO:

<CMS-Server-IpAddress>

• If the SSO certificates are exceeded, you can delete the unwanted SSO certificates from the Onboard
Administrator web interface as follows:
i. Log into the Onboard Administrator web interface.
ii. Click the HP SIM Integration at the end of the tree in the left pane.
iii. Delete the unwanted SSO certificates.

The Onboard Administrator provides a group in the System page called OA role which indicates whether
the OA is active or on standby. For more information, see the Onboard Administrator System page.
Related topics

▲ Navigating the System(s) tab
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Glossary
blade server A server that is located in a rack or enclosure.

See also enclosure, racks.
Central
Management
Server (CMS)

A system in the management domain that executes the HP SIM software. All central operations
within HP SIM are initiated from this system.

collections The method for grouping system or event searches.
container A rack or an enclosure is considered a container.

See also enclosure, racks.
critical status A state generated when HP Systems Insight Manager can no longer communicate to a managed

system.
Desktop
Management
Interface (DMI)

An industry standard protocol, primarily used in client management, established by the DMTF.
DMI provides an efficient means of reporting client system problems. DMI-compliant computers
can send status information to a central management system over a network.

discovery A feature within a management application that finds and identifies network objects. In HP
management applications, discovery finds and identifies all the HP systems within a specified
network range.

Domain Name
Service (DNS)

A service that translates domain names into IP addresses.

enclosure A physical container for a set of blades servers. It consists of a backplane that routes power and
communication signals and additional hardware for cabling and thermal issues. It also hosts the
CPU or server power supplies.

event Information sent to certain users that something in the managed environment has changed. Events
are generated from SNMP traps and are preconfigured in this release. HP Systems Insight Manager
receives a trap when an important event occurs. Events are defined as:

• Informational. Events of this type require no attention and are provided as useful
information.

• Normal. Events of this type indicate that this event is not a problem.

• Minor. Events of this type indicate a warning condition that can escalate into a more
serious problem.

• Major. Events of this type indicate an impending failure.

• Critical. Events of this type indicate a failure and signal the need for immediate attention.

full-configuration-rights user
A user who is automatically authorized for the All Tools toolbox on all systems, including the
CMS. This type of user has been given special privileges to administer the HP Systems Insight
Manager software.

hardware status The operating state of SNMP-based systems. A hardware status is determined by polling SNMP
information from the system. Status is defined as:

• Critical. HP Systems Insight Manager can no longer communicate with the system. The
system was previously discovered, but cannot be pinged. The system might be down, powered
off, or no longer accessible on the network because of network problems.

• Major. A problem exists.

• Minor. The system is functioning but with errors.
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• Normal. The system is functioning correctly.

• Unknown. HP Systems Insight Manager is not able to obtain management information
about the system.

▲ Disabled

health status Health status is an aggregate status all of the status sources (which can be SNMP, WBEM, DMI,
and HTTP) with the most critical status being displayed.
See also system health status.

HP Systems Insight
Manager (HP SIM)

System management software that is capable of managing a wide variety of systems, including
HP systems, clusters, desktops, workstations, and portables.
HP SIM; combines the strengths of Insight Manager 7, HP Toptools, and HP Servicecontrol
Manager to deliver a single tool for managing HP ProLiant, Integrity, and HP 9000 systems
running Windows, Linux, and HP-UX. The core HP SIM software delivers the essential capabilities
required to manage all HP server platforms. HP SIM can also be extended to deliver unparalleled
breadth of system management with plug-ins for HP storage, power, client, and printer products.
Plug-ins for rapid deployment, performance management, and workload management enable
systems administrators to pick the value added software required to deliver complete lifecycle
management of their hardware assets.

HP Systems Insight
Manager database
(database)

The database that stores vital information about HP Systems Insight Manager, including users,
systems, and toolboxes.

identification An aspect of the discovery process that identifies the management protocol and type of system.
Internet Protocol
(IP)

Specifies the format of datagrams (packets) and the addressing scheme on a network. Most
networks combine IP with Transmission Control Protocol (TCP), which establishes a virtual
connection between a destination and a source.

Major status Aggregate status information collected from the system that indicates one or more of the monitored
subsystems are not operating properly which is impacting the system. Action should be taken
immediately.

Minor status Aggregate status information collected from the system that indicates one or more of the monitored
subsystems are not operating properly which is impacting the system. Action should be taken as
soon as possible to prevent further failure.

Onboard
Administrator

The Onboard Administrator is the central point for controlling an entire c-Class rack. It offers
configuration, power, and administrative control over the rack, and its associated blades (Compute
Servers), blade management processors (iLOs), network switches (depending on the models of
switches used) and storage components (such as SAN or SATA). The Onboard Administrator is
a single management processor, with shared resources to an optional backup twin processor for
failover.

racks A set of components cabled together to communicate between themselves. A rack is a container
for an enclosure.

server blade Typically a very dense server system containing microprocessors, memory, and network connections
that can be easily inserted into a rack-mountable enclosure to share power supplies, fans, switches,
and other components with other server blades. Server blades tend to be more cost-efficient,
faster to deploy, and easier to adapt to growth and change than traditional rack-mounted or
tower servers.
See also enclosure, racks.

Simple Network
Management
Protocol (SNMP)

One of the management protocols supported by HP Systems Insight Manager. Traditional
management protocol used extensively by networking systems and most servers. MIB-2 is the
standard information available consistently across all vendors.

system Nodes on the network that communicate through TCP/IP or IPX. To manage a system, some type
of management protocol (for example, SNMP, DMI, or WBEM) must be present on the system.
Examples of systems include servers, workstations, desktops, portables, routers, switches, hubs,
and gateways.
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system health
status

This is aggregate status all of the status sources (which can be SNMP, WBEM, DMI, and HTTP)
that are supported on a target system, with the most critical status being displayed. The following
are the different system health statuses that can be displayed:

• Critical HP SIM can no longer communicate with the system. The system was previously
discovered but cannot be pinged. The system might be down, powered off, or no longer
accessible on the network because of network problems.

• Major A major problem exists with this system. It should be addressed immediately. For
systems running an HP Insight Management Agent, some component has failed. The system
might no longer be properly functioning, and data loss can occur.

• Minor A minor problem exists with this system. For systems running Insight Management
Agent, some component has failed but the system is still functioning.

• Warning The system has a potential problem or is in a state that might become a problem.

• Normal The system is functioning correctly.

• Disabled The system is disabled from monitoring but is not necessarily turned off.

• Unknown HP SIM cannot obtain management information about the system.

• Informational The system might be in a transitional or non-error state.

uncleared event
status

Events that have a Critical, Major, Minor, Normal, or Informational severity.

Critical. A failure has occurred, and immediate attention is required.•

• Major. A failure is impending.

• Minor. A warning condition exists that can escalate into a more serious problem.

• Normal. These events are not a problem.

• Informational. No attention require. This status is provided as useful information

unknown status HP Systems Insight Manager is not able to obtain management information about the system
using SNMP or DMI. Although no management instrumentation information is available, the
system can be pinged. It might have an invalid community string or security setting.

user A network user with a valid login on the CMS that has been added to HP Systems Insight Manager.
Version Control
Agent (VCA)

An agent that is installed on a server to enable you to see the HP software installed on that server.
The VCA can be configured to point to a VCRM agent, enabling easy version comparison and
software update from the repository.

Web-Based
Enterprise

An Industry initiative to provide management of systems, networks, users, and applications across
multiple vendor environments. WBEM simplifies system management, providing better access to
both software and hardware data that is readable by WBEM compliant applications.Management

(WBEM)
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